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1. Installation

MIRLSim is an application file which can be downloaded by following the link below 

http://mirl.uaf.edu 

1.1 System Requirements 

Software 

This version is compatible with Windows and has been tested on Windows 7. It will work well 

with any Windows 7 or newer versions (32-bit and 64-bit). It does not require any additional 

external program to run. The minimum system requirement is: 

• Dual Core processor

• 2 GB RAM

Hardware: 

The software will acquire a disk space of 98 MB 

1. After downloading the package run the installation wizard by clicking on  .exe 

icon.

2. Complete the installation as directed

3. After the software is installed it is ready for use.

Attribution and License: 

This workforce product was funded by an $8.1M TAACCCT grant awarded by the U.S. 

Department of Labor’s Employment and Training Administration. The product was created by the 

grantee and does not necessarily reflect the official position of the U.S. Department of Labor. The 

U.S. Department of Labor makes no guarantees, warranties, or assurances of any kind, express or 

implied, with respect to such information, including any information on linked sites and including, 

but not limited to, accuracy of the information or its completeness, timeliness, usefulness, 

adequacy, continued availability, or ownership.

Creative Commons License Type: CCBY 4.0 

http://mirl.uaf.edu/
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2. Different Unit Processes

Right clicking on the empty template will open a dialog box as shown below. The user can select 

any item on the list to start drawing the circuit. 

There are six unit process that the user can add to their circuit. They are as follows: 

1. Feed

2. Ball Mill

3. Semi-Autogenous Mill (SAG Mill)

4. Hydrocyclone

5. Sump Pump

6. Screen

Apart from these six unit processes, there are some added features that makes the simulator easy 

to use. They necessarily do not exist in plants, but help the user in simplifying/understanding the 

circuit easy. They are as follows: 

1. Splitter 2

2. Splitter 4

3. Junction 2

4. Junction 4

5. Sub circuit

6. Circuit output

Details regarding each equipment will be stated in the following pages. 
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2.1 Feed 

 
 Feed Icon 

Right clicking on the feed icon will open menu named “Input Source Settings”. By clicking, it 

will open a new tab in which the user can change the settings regarding the input to the circuit. 

                           

 

The maximum tonnage from a single feed is set at 2000 tph. If the user wants to have a feed 

greater than 2000 tph, they can add more feed to the circuit. 

 

 

In this tab the user can change the ore characteristics like specific gravity, specific gravity of 

water, propagation delay, and tonnage of water. By default, the passing fraction of different size 
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ranges is set as shown in the image below, but the user can enter their own values as long as they 

are logical.  

 
 

The “Output” tab will show the weight distribution of the input feed and also different 

calculations like Power (in kW), pulp TPH, etc. 

 

The “Graph” tab will show the different graphs. 

 

 

The user can change the feed tonnage by dragging the slider on the feed icon left or right. 
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The “Script” allows the user to enter or save the current scenario to run the simulations. The files 

must be MS Excel (converted to .csv files). Here the user can also upload their own MS Excel 

file by clicking on the “Script” icon and then selecting “Load CSV” button. 

 
 

 

2.2 Ball Mill 

 

Ball Mill Icon 

 

To change settings of Ball Mill, the user has to right click on the ball mill icon. A menu will pop 

up with the title “Mill Settings”.  

 

On clicking the icon, a tab containing all the parameters will open. 
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“Propagation delay” means the delay in output of ball mill. 1 step delay is equal to 1 second. So 

if a user opts for larger step delay, the output of ball mill will take longer to display. 

“Appearance Function” relates to the retention of material in the ball mill. In the ideal situation, 

there will be no retention of material in the ball mill. If the user wants no retention of material in 

the ball mill, then they can check the “Use appearance function” box.  

 



MIRLSim Manual         UAF 

9 

 

 

The above two tabs show the difference between the weight distribution in different size ranges 

for a particular input and output of a ball mill. 

The variables for the ball mill include the ball density (in gm/cm3), ball diameter (in meter), belly 

length (in meter), mill diameter (in meter), volume of balls (in %), and rotation speed (in RPM). 

After making all the changes, the user has to save them by clicking on the “Save” button. 

Similar to the feed, the user can change the RPM of ball mill by dragging the slider on the ball 

mill icon left or right. 

The “Graph” tab will show the different graphs. 

 

Similar to the feed, the user can change the RPM of ball mill by dragging the slider on the ball 

mill icon left or right.  

“Selection Matrix” allows the user to choose which size range they want to break more or less. 
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2.3 Semi Autogenous Mill (SAG Mill) 

 

                                             SAG Mill Icon 

To change the SAG Mill settings, the user can right click on the “SAG Mill” icon. A menu will 

pop up with the title “Mill Settings”.  
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On clicking the icon, a tab containing all the parameters will open. 

 

“Propagation delay” means the delay in output of SAG mill. 1 step delay is equal to 1 iteration. 

So if a user opts for larger step delay, the output of SAG mill will take longer to display. 

 

“Appearance Function” relates to the retention of material in the SAG mill. In the ideal situation, 

there will be no retention of material in the ball mill. If the user wants no retention of material in 
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the SAG mill, then they can check the “Use appearance Function” box. 

The variables for the SAG mill include the ball density (in gm/cm3), ball diameter (in meter), 

belly length (in meter), center line length (in meter), mill diameter (in meter), volume of balls (in 

%), and rotation speed (in RPM). 

After making all the changes, the user has to save them by clicking on the “Save” button. 

Similar to the feed, the user can change the RPM of SAG mill by dragging the slider on the SAG 

mii icon left or right. 
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The previous two tabs show the difference between the weight distribution in different size 

ranges for a particular input and output of a SAG mill. 

The “Graph” tab will show the different graphs. 

Similar to the previous unit operations, the user can choose to upload their own script and 

selection matrix. 

2.4 Hydrocyclone 

     Hydrocyclone Icon 

The hydrocyclone will have two outlets and one inlet. The two outlets are overflow and 

underflow while one inlet is feed. 

Hydrocyclone icon showing two outlets 
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To change the hydrocyclone settings, the user can right click on the “Hydrocyclone” icon. A 

menu will pop up with the title “Hydrocyclone Settings”.  

 

On clicking the icon, a tab containing all the parameters will open. 

 

 

The variables for the hydrocyclone include the apex diameter (in centimeter), distance between 

Apex and Vortex (in centimeter), cyclone diameter (in centimeter), hydrodynamic exponent, 

inlet diameter (in centimeter), number of hydrocyclone, overflow diameter (in in centimeter), 

propagation delay and liquid viscosity (in centipoise). 
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The user can change the parameters by editing the values in appropriate boxes. To save these 

changes, the user has to click on the “Save” button. 

In a circuit, the hydrocyclone is always paired with the sump pump to provide water to it. 

Without the addition of sump pump, the hydrocyclone will give wrong output. 
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The previous three tabs show the input and output of a hydrocyclone. The user can see the output 

of both the overflow and underflow in the same table. 

 

The above three tabs show the difference between the weight distribution in different size ranges 

for a particular input and output of a hydrocyclone. 

 

The “Graph” tab will show the different graphs for underflow and overflow. 

 

 

The hydrocyclone is a very sensitive equipment and minor changes in the parameters can affect 

the performance. Below, the range of each parameter is mentioned where the hydrocyclone will 

work. 

 



MIRLSim Manual         UAF 

17 

 

Inlet area: 7% of cross section of cylindrical chamber 

Vortex finder area: 30% of cyclone diameter 

Apex diameter: 10-35% of the cyclone diameter 

Cone angle: 10o-20o 

 

2.5 Sump Pump 

 

                                                            Sump Pump Icon 

To change the sump pump settings, the user can right click on the “SumpPump” icon. A menu 

will pop up with the title “SumpPump Settings”.  
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Here, the user has the option to change propagation delay, tonnage of water and the specific 

gravity of water. Changing specific gravity of water implies that the sump pump is now pumping 

a liquid that is not water. 

 

 

 
 

As the sump pump is not a separate unit process, the output and input tabs will show the same 

data. The sump pump is there only to add water to the existing circuit parameters. It is used in 

conjunction with hydrocyclone. 
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  2.6 Screens 

 

  

Screen Icon 

 

Just like the hydrocyclone, the screen has two outputs, namely, overflow and underflow. 

 

To change the screen settings, the user can right click on the screen icon and then click on the 

“Screen Settings” button. 

 

The following window opens after clicking on the “Screen Settings”. 
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Here, the user has the option of setting their own coarse bypass fraction (R1), fine bypass 

fraction (R2), cut size (d50c in mm), propagation delay and separation efficiency (α). 

 

The above table shows the feed size range and the corresponding tonnage. 

 

 

The table above shows the amount of particles in each size range for overflow and underflow of 

a screen. Oversize means particles that overflow while undersize means particles that pass 

through the screen and report to underflow. 
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The “Graph” tab will show the different graphs. 

 

 

 2.7 Splitter 2 

 

 Splitter 2 Icon 

 

Splitter 2 is used to split an input stream into two output streams. 

 

To change the Splitter 2 settings, the user can right click on the splitter icon and then click on the 

“Splitter 2 Settings” button. 
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In the above tab, user can select the number of outputs from the splitter and set the respective 

percentage. 

“Propagation delay” means the delay in output of splitter. 1 step delay is equal to 1 iteration. So 

if a user opts for larger step delay, the output of splitter will take longer to display. 

 

In the “Input” and “Output” tab the user can see the input and output of the splitter.  

The splitter does not change the physical properties of the incoming feed. It only splits them into 

two or more parts. 

The user can see the graphs for different outputs by clicking on the “Graph” tab. 

 

 2.8 Splitter 4 

 

Splitter 4 Icon 
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Splitter 4 is used to split an input stream into four output streams. 

 

To change the Splitter 4 settings, the user can right click on the splitter icon and then click on the 

“Splitter 4 Settings” button. 

 

 

In the above tab, user can select the number of outputs from the splitter and set the respective 

percentage. 
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“Propagation delay” means the delay in output of splitter. 1 step delay is equal to 1 iteration. So 

if a user opts for larger step delay, the output of splitter will take longer to display. 

In the “Input” and “Output” tab the user can see the input and output of the splitter.  

The splitter does not change the physical properties of the incoming feed. It only splits them into 

two or more parts. 

The user can see the graphs for different outputs by clicking on the “Graph” tab. 

 

The main use of splitter is to give freedom to the user so that they can split the feed. They can 

choose to divide the feed and send it to different unit operations and see the results. 

 

 2.9 Junction 2 

 

Junction 2 Icon 

The use of Junction 2 is to join two different streams. 

 

To change the Junction 2 settings, the user can right click on the splitter icon and then click on 

the “Junction 2 Settings” button. 

 

In the above tab, the user can only change “Propagation Delay”. 
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2.10 Junction 4 

 

                                                                 Junction 4 Icon 

The use of Junction 4 is to join four different streams. 

                 

To change the Junction 4 settings, the user can right click on the splitter icon and then click on 

the “Junction 4 Settings” button. 

 

 

 

In the above tab, the user can only change “Propagation Delay”. 
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  2.11 Sub Circuit 

                        

Sub Circuit Icon 

The sub circuit is just the extension of normal screen. It gives the user flexibility to expand the 

circuit or construct complicated circuits. 

When the user click on “+”, a new tab opens up as shown below: 

 

The screenshot below shows the “sub circuit” tab. 

 

2.12 Circuit Output 

 

 

 Circuit Output Icon 

The circuit output displays the output of the circuit. Similar to the splitter, it does not change any 

physical properties. 
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Right clicking on the circuit output icon opens a message box named “OutputSink Settings” from 

where the user can change the propagation delay. 

 

 

 

In every unit operation parameter, the maximum permissible values are mentioned. The user 

should keep the values within that limit. 
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3.   Operation 

 

3.1 Getting Started  

1. On running the application the user will see white canvas which serves as a drawing 

board to draw any flow sheet. 

 

Figure 1: Drawing Canvas 

 

At the bottom right side of the canvas, the user can see two clocks labelled “Run Time” and 

“Simulation Time”. Run time shows the time since the simulation was started while the 

simulation time shows the time for which the process runs in real time at a processing plant. The 

simulation time can be adjusted by dragging the simulation speed slider left or right. 

At simulation speed of “1”, 1 second of run time is equivalent to 30 seconds of simulation time 

while at a simulation speed of “600”, 1 second of run time is equivalent to 30 minutes of 

simulation time. 

The simulator creates “CSV” files which contains data from different unit process at different 

times. The software gives user the freedom to select a time period to do the sampling. This 

means if the user selects a sample period of 10 minutes, the simulator will record the data at 

every 10 minute interval and store it in a csv format.  
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If the user wishes not to store the data, then they can uncheck the “Enable Sampling” radio 

button at the bottom right corner of the simulator window. 

2. Right click anywhere on the drawing board to access the equipments icon library, you 

can also access icon library by going to Menu Bar under Edit > Add. 

 

 

 

 

 

Figure 2: Add Equipment 

3. The library consists of equipments of the comminution and classification processes such 

as grinding, classification and handling units.  

 

4. Select the equipments based on your choice or the flowsheet you are attempting to draw. 

The version is modular in nature and the order of equipment selection will not affect the 

simulation results. 

 

5. The equipment icons can be placed anywhere on the drawing canvas by: 

a. Selecting the icon by clicking on icon you want to move. Upon clicking, the icon 

gets highlighted and green “+” sign appears (Figure 1Figure 3).   

b. You can also drag multiple icons by pressing CTRL and selecting multiple units 

by clicking on it.   
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Figure 3: Selection of Equipment Icon, Left: Single Unit, Right: Multiple Unit 

6. Once the units are in place it should be interconnected by the stream lines which

represents the flow of material (solid, water and slurry) from one equipment to another.

7. The stream line between two equipments can be drawn by selecting the equipment from

which the stream line will be originating.

i) After selecting equipment icon will be highlighted and “+” sign will appear. Upon

clicking the “+” sign, you can see the possibilities of joining the line other units.
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Figure 4: Possibilities for joining stream lines 

 

The dotted line turns green when the pointer reaches another “+” sign which means that 

the user can connect the stream as shown in the above screenshots. 

ii) Click on the other “+” sign, the stream line will appear itself.  

 

Figure 5: Create Stream Line 

iii) Stream line can be deleted by reselecting them (which turns them into green) and 

pressing Delete button on keyboard. 
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Figure 6: Delete Stream Line 

 

8. Ensure all the equipments are properly connected. The product stream should be 

connected to circuit output. In case of multiple product, multiple circuit output should be 

selected (Figure 7).  

 

Figure 7: Product Stream 
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9. The flowsheet drawn can be saved as well. The software has the feature to save the

flowsheet anytime when the application is running. This can be done by going to Menu

Bar and selecting File > Save or by using the “Save As” function also.

Enter the desired file name of the flowsheet and click save. The flowsheet will be saved 

with an extension .sim. 

If the user changes the settings of individual unit processes and saves the flowsheet, it 

will be saved with an extension .mirl_scenario. 

3.2 Data  

Once the flowsheet is drawn, it requires design and operating data for simulation. This includes 

dimension of the equipments and operating feed, water and other model parameters. 

1. The data can be entered by double clicking the equipment icon.

2. A dialog box of equipment settings appears, typical example of a ball mill is shown in

Figure 8.

3. User can enter the design specification by typing in value for a particular process unit or

by clicking arrows provided. Default value of parameters are already being provided.

4. The ore characteristics data such as particle size distribution and weight distribution can

also be changed under circuit setting option.

a. This can be accessed by going to Menu Bar under Edit > Circuit Settings.
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Figure 8: Equipment Setting Dialog for Ball Mill 

b. Enter the size range which you intend to simulate and corresponding particle size

distribution will change and then hit save. The size ranges should be in microns.
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Figure 9: Circuit Settings 

 

 

 

3.3 Simulating the flowsheet 

After entering the data the simulator is ready to use. The simulation can be started by clicking the 

Start button at the bottom left corner of the interface. Similarly the simulation can be stopped by 

clicking Stop button next to start. On clicking the Step button, only one iteration is done. This is 

helpful in visualizing material flow step by step. Reset button resets the circuit to the original 

state.  
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Figure 10: Start/Stop Simulations 

 

 

The simulator is equipped with the feature to increase and decrease the simulation speed which is 

the number of iteration or calculation the simulator will be performing in a minute. This can be 

adjusted through a slider labelled “Simulation Speed” provided at the bottom center of the main 

drawing canvas.  
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3.4 Simulation Results 

The simulation results and the response of the variables can be viewed in two ways. One is on 

the equipment basis i.e. the input and output response associated with each equipment while the 

other is few selected process variables which are/can be allowed displayed on the drawing 

canvas. 

1) Input and output response of the variables associated with every equipment can be accessed 

by double clicking the equipment icon of the equipment. For example in Figure 8 for a ball 

mill the dialog box contains input and output tabs next to settings tab ( 

Figure 11). 

 
Figure 11: Input-Output Tabs 

 

Figure 12 shows the input data to sag mill at a particular instance of simulation.  

 

Figure 12: Input Data to Ball Mill 

2) From an operator or an engineer’s prospective process variables such as mass flow rate of 

solids/water or percent solids, mill power, product particle size etc. are monitored at regular 

interval and are crucial. Hence, the simulator allows these variable to be displayed on main 

drawing canvas simulator allow to view these variables from the dashboard. These variables 

are displayed with the stream originating from the equipment (Figure 133).  
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Figure 13: Display of process variables on drawing canvas 

Onscreen displays four variables and the choice of the variable can be made by clicking drop 

down arrows under menu bar (top – left corner below File option, Error! Reference source not 

found.). 

Figure 14: Choosing variables to be displayed 

User can also see the trends of the selected variable and how they change with time during the 

simulation. For example in Figure 13 the user can see how mill response (power) has changed by 

clicking on the values displayed.  
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Figure 15: Data Trends 

4. Example

People not directly related to Mining/Mineral industry or having less technical knowledge in the 

field can start with the example flowsheet of a typical grinding circuit of a gold mine operating 

in Alaska.   

4.1 Circuit Description 

This flowsheet consists of a feeder, sag mill, ball mill, hydrocyclone and sump-pumps. The sag 

mill is used for primary grinding, (i.e. it will reduce the size of incoming feed to a certain limit) 

which is fed by the means of a feeder. The material after being reduced in size in sag mill is 

discharged into a sump pump. This material is then transferred to ball mill for further size 

reduction operating in close circuit with a cyclone (Figure ). 

The ground material is then subjected to classification based on size using cyclone of a particular 

cut size. The underflow which is the coarse material is sent to ball mill for further size reduction 

while the overflow is reported to circuit output for subsequent operation.  

So our circuit has: 

• Solid tonnage, water to sag mill, sag mill discharge sump and cyclone sump as inputs to

the circuit which are manipulated variables and can be changed during the simulation.

• The main product of the circuit is cyclone overflow whose size is supposed to be in the

range of 60 + 10 microns.

• Along with that the response of the circuit includes solid mass flow rate, water

volumetric flow rate, particle size of the respective streams and cyclone overflow and

mill power.
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Figure 16: Example Flowsheet 

The design and other model parameters are pre-defined.  

4.2 Objective 

As an operator your objective is to ensure all the response variables which are critical from 

operational point of view are within acceptable limit ensuring maximum production.  

Task: 

• Maintain circuit output particle size and maximize solid tph.

• Maintain sag mill power in the range of 500 kW to 550 kW by varying the operating

speed (but the maximum permissible limit of the speed is 14.6 rpm which is 80 percent of

critical speed).

• Maintain ball power in the range of 570 kW to 630 kW by varying the rpm from 14.3 to a

maximum value of 16.8.

• Mill power is also affected by feed tonnage and water addition to the mill. Indicate how

the response is affected by changing both.

• Ensure cyclone overflow is in range of 50 to 70 micron. Overgrinding also leads to

reduced recovery for downstream processes.

• Less fluctuation is response and input resembles smooth operation.

• Operate sag in a percent solid range of 65-75.
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• Ball mill percent solid in the range of 45- 55. 

 

 

Explain the following  

• Effect of cyclone feed specific gravity on overflow size. 

• Effect of percent solids on hydrocyclone outputs.  

 

5. Reference  

AMIT 135 & AMIT 145 Course Content 

http://mirl.uaf.edu/research/preparing-the-unemployed-for-the-mining-sector-a-taaccct-funded-

project/  

 
 

 

  

 

 

 

http://mirl.uaf.edu/research/preparing-the-unemployed-for-the-mining-sector-a-taaccct-funded-project/
http://mirl.uaf.edu/research/preparing-the-unemployed-for-the-mining-sector-a-taaccct-funded-project/



